
Прежде чем приступить к проекту,

разработчик должен иметь в своём

распоряжении библиотеку компонен�

тов элементной базы, используемой в

проекте. Хотя библиотеки, поставляе�

мые с Altium Designer, содержат поряд�

ка 86 000 компонентов (www.alti�

um.com/Community/support/Libraries/

Designer6libraries – описание всех биб�

лиотек), существуют сомнения относи�

тельно целесообразности их использо�

вания. Во�первых, УГО (условные гра�

фические обозначения) всех этих

компонентов не соответствуют ГОСТ,

во�вторых, в этих библиотеках отсут�

ствует российская элементная база, ко�

торая применяется на наших предпри�

ятиях. Поэтому перед разработкой

электрических принципиальных схем

и проектированием плат следует рас�

смотреть порядок разработки библио�

тек и моделей компонентов, а также

разные подходы к их организации.

КОНЦЕПЦИЯ БИБЛИОТЕК

ALTIUM DESIGNER

Компоненты являются основными

блоками электронных изделий. При

разработке и подготовке к производ�

ству проекта каждый компонент нуж�

дается в различных представлениях:

логический символ на схеме (УГО), по�

садочное место на плате (Footprint),

описание в формате Space для модели�

рования, описание IBIS�модели для

анализа целостности сигналов и трёх�

мерное описание для объёмного

представления готовой платы.

Не обязательно наличие всех этих

представлений для каждого компо�

нента, но необходимо наличие стар�

товой точки, которой в Altium Desig�

ner является логический символ

(УГО). Каждый компонент должен

быть определён как минимум назва�

нием в схемной библиотеке. Он может

содержать выводы и графический

символ в единственном или многосек�

ционном виде и даже иметь альтерна�

тивные отображения. Как таковой он

может быть размещён в любом схем�

ном проекте. Однако, до тех пор, пока

в компонент не добавлены модели, его

нельзя применить на практике.

Для однозначного понимания разъ�

ясним термины, наиболее часто ис�

пользуемые в среде Altium Designer.

Компонент: общее наименование

объекта, который может быть приме�

нён в проекте.

Символ: общее наименование гра�

фического представления компонен�

та, подготовленного для размещения

на схеме. Символ может содержать

графические объекты, которые опре�

деляют внешний вид и выводы для

электрического подключения.

Физический компонент может быть

смонтирован на плате.

Логический символ: схемное пред�

ставление физического компонента.

Часть (секция): некоторые компо�

ненты, такие как цепочки резисторов

или реле, могут быть построены в ви�

де серии отдельных секций (частей),

которые, в свою очередь, могут быть

размещены на схеме независимо

(рассматриваются как многосекци�

онный компонент).

Модель: представление компонента,

который используется в некоторой

практической сфере деятельности.

Посадочное место: это наименова�

ние используется для модели, кото�

рая представляет компонент на заго�

товке печатной платы. Посадочное

место группирует набор контактных

площадок (КП) на плате и изображе�

ние корпуса компонента и определя�

ет часть платы, требуемую для монта�

жа и подсоединения физического

компонента на плате.

Библиотека: файл, содержащий

набор компонентов и набор моделей.
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В статье приведены основные понятия о библиотеках и моделях

компонентов в программе Altium Designer.

Altium Designer Summer 08 –
разработка библиотек
и моделей компонентов
Алексей Сабунин (Москва)

Библиотека моделей: файл, содер�

жащий набор моделей компонентов.

Библиотека компонентов: файл,

содержащий набор схемных компо�

нентов.

Интегрированная библиотека:

файл, содержащий набор схемных

компонентов и их ассоциированные

модели.

Библиотека базы данных: библиоте�

ка компонентов, где все символы име�

ют ссылки, модели связаны и парамет�

рическая информация сохранена в ба�

зе данных на основе ODBC (open

database connectivity – интерфейс свя�

зи с открытыми базами данных), ADO

(ActiveX Data Objects – набор компо�

нентов ActiveX, используемых для до�

ступа к БД, поддерживающим специ�

фикацию OLE DB) или в виде таблиц

Excel.

На схемной стадии проект является

набором компонентов, которые име�

ют логическую связность (см. рис. 1).

Для тестирования или реализации

проект нуждается в передаче в дру�

гую область проверки функциониро�

вания, такую как моделирование,

формирование платы, анализ целост�

ности сигналов и т.д.

Каждая область практической ре�

ализации требует некоторой ин�

формации о компонентах, а также о

путях перераспределения этой ин�

формации через выводы символа.

Некоторая часть этой информации

для области реализации размещается

в файлах моделей, формат которых

является обычно предопределённым.

Например, модели IBIS, MDL (прин�

цип минимальной длины описания)

и CKT. Некоторая информация не со�

держится в файлах моделей, – напри�

мер, распределение выводов SPICE и

данные списков цепей должны быть

определены средствами системы.

Отметим, что модели целостности

сигналов IBIS и модели VRML (virtual

reality modeling language – язык моде�

лирования виртуальной реальности)

или IGES 3D (международный язык

обмена графической информацией)
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должны быть предварительно им�

портированы в формат модели

Altium Designer. Модели IBIS импор�

тируются непосредственно в диалоге

Signal Integrity Model, который от�

крывается при добавлении SI�модели

в компонент. VRML� и IGES�модели

должны быть импортированы в

PCB3Dlib перед тем, как они могут

быть добавлены в компонент схемы.

Вся необходимая информация до�

мена содержится внутри схемного

компонента, который сохраняется с

помощью отдельного интерфейса

для каждой добавляемой модели (см.

рис. 2). В сущности комплектная мо�

дель является комбинацией распре�

делённой информации моделей, со�

храняемой в компоненте, а информа�

ция о модели домена сохраняется в

библиотеке моделей.

В среде Altium Designer существуют

четыре типа доступных для исполь�

зования библиотек.

Библиотеки моделей – модели для

каждой области сохраняются в «хра�

нилищах», обычно называемых биб�

лиотеками моделей. В некоторых об�

ластях, таких как SPICE, где обычно

одна модель хранится в одном файле,

они также рассматриваются как от�

дельные файлы (*.MDL, *.CKT). В дру�

гих областях модели обычно группи�

руются в библиотечные файлы, соот�

ветствующие заданной организации

пользователя, такие как посадочные

места, сгруппированные в библиоте�

ки пакетного типа (*.PcbLib).

Библиотеки символов содержат

схемные компоненты и интерфейс

определения их моделей (*.SchLib).

Каждый интерфейс определения мо�

дели привязан к своей соответствую�

щей библиотеке моделей.

Интегрированные библиотеки –

это наборы библиотек символов, ко�

торые вместе с их привязанными

библиотеками моделей «компилиро�

ваны» в интегрированную библиотеку

(*.IntLib). Преимущество создания ин�

тегрированных библиотек состоит в

том, что вся компонентная информа�

ция доступна в едином файле. Интег�

рированные библиотеки не могут

быть отредактированы без распаков�

ки источников и перекомпиляции.

Библиотека базы данных – библио�

тека, где все символьные ссылки, при�

вязанные модели и параметрическая

информация хранятся в базе данных

на основе ODBC, ADO или в формате

таблиц Excel. Каждая запись в базе

данных представляет отдельный ком�

понент, а также все сохраненные па�

раметры, вместе со ссылками на моде�

ли. Запись может содержать ссылки

на инвентарную ведомость или на

другие корпоративные данные о ком�

понентах.

При таком подходе схемные ком�

поненты используются только в виде

символов (они не имеют ссылок на

модели, описанные в схемной библи�

отеки) с моделями (посадочными

местами или 3D�моделями), сохра�

нёнными в стандартных библиоте�

ках посадочных мест, 3D�компонен�

тов и т.д.

Интерфейсом библиотеки базы

данных является документ *.DBLib,

который описывает, какие поля базы

данных требуются и какие парамет�

ры компонентов они отображают.

База данных DBLib подключается че�

рез панель Libraries подобно всем

другим библиотекам системы.

При выполнении действий по раз�

мещению, выполняемых с компо�

нентами библиотеки базы данных,

запись в базе данных проверяется,

символ загружается из указанной

схемной библиотеки и модели добав�

ляются к любым указанным моделям,

так же как параметры.
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Рис. 1. Информация о различных вариантах представления компонента в файлах моделей

Рис. 2. Связи в каждой модели и любое её переопределение требуют определения модели

в соответствующем диалоге



РАЗРАБОТКА УГО
КОМПОНЕНТОВ

Предполагается, что программа

Altium Designer уже запущена на

компьютере. Для создания новой

библиотеки необходимо выполнить:

File > New > Library > Schematic Library.

Для работы с библиотекой символов

необходимо открыть панель (кото�

рая вызывается по кнопке SCH > SCH

Library в нижней левой части окна) и

разместить её слева от рабочей об�

ласти (о размещении панелей см. СЭ

№ 5, 2008), после чего интерфейс

Altium Designer будет иметь вид, по�

казанный на рисунке 3.

Прежде чем приступить к разра�

ботке нового символа, необходимо

настроить рабочую область, т.е. вы�

брать необходимые единицы измере�

ния и сетки. Данная настройка про�

изводится в окне Library Editor Work$

space, которое вызывается командой

Tools>Document Options. В появив�

шемся окне на вкладке Units выбира�

ются единицы измерения, причём

они могут быть метрические и дюй�

мовые (в нашем случае следует уста�

новить миллиметры). На вкладке

Library Editor Options следует устано�

вить шаг сетки 2,5 мм для двух видов

сеток (Snap – сетка перемещения кур�

сора в режиме графической коман�

ды, Visible – сетка, отображаемая на

экране). Кроме сеток, на данной

вкладке могут быть установлены до�

полнительные параметры (см. рис. 4).

Рассмотрим алгоритм создания

компонента на примере микросхе�

мы, изображённой на рисунке 5. Для

создания компонента следует нажать

кнопку Add под списком компонен�

тов данной библиотеки в панели SCH

Library и в появившемся окне напи�

сать название нового компонента. В

результате этого новый компонент

добавляется в список библиотеки. Да�

лее процесс создания компонента

можно разбить на три этапа:

● установка выводов компонента;

● рисование графики символа;

● установка параметров (атрибутов).

1. Выводы компонента устанавлива�

ются командой Place > Pin, причём

сразу после выполнения этой ко�

манды вывод становится привя�

занным к курсору, и в этот момент

необходимо нажать клавишу Tab

для установки свойств вывода. В

открывшемся окне (см. рис. 6) сле�

дует указать название и позицион�

ное обозначение вывода, которое

соответствует номеру вывода кор�

пуса микросхемы. Обязательно сле�

дует указать длину вывода, кратную

2,5 мм; остальные параметры, такие

как электрический тип вывода и

специальные символы, добавляют�

ся позже. При установке вывода он

привязан к курсору большим верти�

кальным крестом, с другой стороны

маленький диагональный крестик

показывает электрическое оконча�

ние вывода (см. рис. 7). Для разме�

щения первого вывода данного

компонента его следует развернуть

на 180 градусов нажатием клавиши

Space (пробел). Установка вывода

производится нажатием левой

кнопки мыши, причём после уста�

новки в электрическом окончании

вывода показаны четыре белые точ�

ки. Установим три вывода, как пока�

зано на рисунке 5, причём у вывода

3 следует отобразить инверсию, для

чего в свойствах компонента пара�

метру Outside Edge (символ снаружи

на границе контура) выбирается

значение Dot (Знак инверсии).

2. На втором этапе создаётся графика

УГО, для чего используются коман�
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Рис. 3. Интерфейс редактора компонентов

Рис. 4. Настройки рабочей области редактора символов

Рис. 5. Пример компонента – микросхема

К1554ЛА3



ды рисования (line, Ellipses, Arc и

др.). В нашем случае выбираем ко�

манду Place > Line и рисуем прямо�

угольник, как показано на рисунке 5.

Толщина и свойства рисуемой ли�

нии могут быть изменены во время

рисования при нажатии клавиши

Tab, причём толщина линии задаёт�

ся условно Smallest, Small, Medium и

Large (Small соответствует толщине

2,54 мм). При рисовании линии мо�

гут быть использованы пять режи�

мов, переключение между которы�

ми выполняется клавишей Space

(Пробел). Во время рисования гра�

фики символа может возникнуть

необходимость переключения ша�

га сетки. Для переключения между

стандартными режимами сеток

(установка которых будет рассмот�

рена в следующей статье) необхо�

димо нажать клавишу G (при этом

сетка будет циклично переключать�

ся между значениями 1, 2,5 и 5 мм).

При необходимости включить шаг

сетки, отличный от указанных вы�

ше, нажмите последовательно кла�

виши V и G, после чего в появив�

шемся выпадающем меню выбери�

те команду Set Snap Grid.

Создав первую ячейку микросхемы,

необходимо повторить первые два

шага и создать остальные три ячей�

ки, при этом на символе позицион�

ные обозначения выводов должны

совпадать с реальными номерами

выводов микросхемы. Для создания

новой ячейки внутри одного компо�

нента выполняется команда Tools >

> New Part. В рассматриваемом случае

выводы 7 и 14 относятся к питанию

и земле и не должны быть показаны

на символе. Для установки скрытых

выводов необходимо (командой

Place > Pin) зайти в свойства компо�

нента нажатием клавиши Tab. В

свойствах компонента после уста�

новки соответствующего обозначе�

ния и названия следует включить

опцию Hide и в поле Connect To за�

дать название цепи, к которой по

умолчанию будет подключаться

данный вывод. Кроме этого, для та�

ких выводов обычно ставят значе�

ние 0 в поле Part Number, что гово�

рит о непринадлежности данного

вывода к какой�то конкретной ячей�

ке микросхемы. Результат создания

символа показан на рисунке 8.

3. При создании символа в програм�

ме PCAD после вышеописанных

шагов требовалось указать точку

привязки и установить обязатель�

ный атрибут RefDes. В программе

Altium Designer точка привязки

определяется началом координат ра�

бочей области (перекрестие в цент�

ре экрана), а позиционное обозна�

чение (RefDes) автоматически добав�

ляется над корпусом микросхемы.

Третьим этапом при создании сим�

вола является добавление атрибутов,

которые в дальнейшем могут быть

использованы для оформления

текстовой документации (перечней

и спецификаций). В программе

PCAD этот этап выполнялся послед�

ним, при создании компонента в

приложении Library Executive. В

программе Altium Designer в связи с

тем, что изменена структура библио�

тек, компонент создаётся уже сей�

час! Для установки атрибутов компо�

нента необходимо выполнить двой�

ной щелчок мыши на его названии в

панели SCH Library. В появившемся

окне свойств компонента (см. рис. 9)

необходимо указать префикс пози�

ционного обозначения компонента

и при необходимости добавить па�

раметры, которые в дальнейшем мо�

гут быть использованы для создания

спецификации и перечня элемен�

тов. После нажатия кнопки ОК мож�

но выполнить сохранение библио�

теки нажатием пиктограммы с изоб�

ражением дискеты.

РАЗРАБОТКА ПОСАДОЧНЫХ

МЕСТ (FOOTPRINT)
КОМПОНЕНТОВ

При реализации баз компонентов

в программе PCAD использовались

библиотеки одного типа (с расшире�

нием .lib). Эти библиотеки можно бы�

ло назвать интегрированными, т.к.

внутри них хранились символы, по�

садочные места и сами компоненты.

В программе Altium Designer, как бы�

ло показано выше, для каждого типа

объектов имеются свои библиотеки.

При этом библиотеки символов по
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Рис. 6. Свойства вывода компонента

Рис. 7. Установка вывода



сути представляют собой библиоте�

ки компонентов, однако библиотеки

посадочных мест имеют отдельное

расширение; остальные три типа мо�

делей (3D, Spice, IBIS) не имеют свое�

го типа библиотек и хранятся в виде

отдельных файлов.

Итак, после создания компонента в

виде символа микросхемы К1554ЛА3

приступим к созданию посадочного

места этой микросхемы. Начнём с

создания новой библиотеки, для чего

выполним команду File > New > Libra$

ry > PCB Library.

Для работы с редактором посадоч�

ных мест используется панель PCB

Library, которая может не запустить�

ся автоматически. Для отображения

указанной панели необходимо найти

её в группе панелей PCB в левой ниж�

ней части экрана. После этого интер�

фейс программы примет вид, пока�

занный на рисунке 10, причём не�

трудно заметить, что по умолчанию

новый документ запускается в милах

(mil). Такие операции, как настройка

рабочей области, сетки, свойства ли�

нии и других графических объектов

«по умолчанию» мы будем рассмат�

ривать в следующей статье; в данном

случае установим параметры только

для текущей библиотеки.

Для установки параметров выпол�

ним команду Tools>Library Options, и на

экране появится окно, показанное на

рисунке 11, где выставляются едини�

цы измерения (в поле Units), шаг сетки

(Snap Grid), шаг сетки для установки

компонентов (Component Grid, для

библиотек эта сетка не используется)

и две видимые сетки (Grid 1 и Grid 2).

Видимые сетки задаются относитель�

но сетки Snap Grid, первая должна

быть равна шагу сетки, вторая – в де�

сять раз больше, тогда настройки се�

ток Altium Designer будут идентичны

настройкам сеток PCAD. Остальные

параметры в данном окне пока несу�

щественны, поэтому принимаем из�

менения нажатием кнопки ОК. Теперь

на экране отображается светлая сетка,

а при увеличении масштаба изобра�

жения появится тёмная сетка.

Приступим непосредственно к соз�

данию посадочного места, которое

состоит из двух этапов:

● установка контактных площадок;

● разработка графического изобра�

жения корпуса компонента.

Создание посадочного места может

быть выполнено двумя способами:

вручную и с помощью мастера. Сна�

чала рассмотрим «ручной» вариант

на примере посадочного места ре�

зистора, а затем с помощью мастера

реализуем посадочное место для опи�

санной выше микросхемы.

Для создания нового посадочного

места выполним команду Tools > New

Blank Component, после чего в панели

PCB Library появится новое посадоч�

ное место с условным названием. Что�

бы задать необходимое название соз�

даваемому корпусу, необходимо вы�

полнить двойной щелчок мыши на

его надписи в панели PCB Library (в на�

шем случае вводим название Resistor).

1. Для установки контактных площа�

док выполним команду Place > Pad, и

нажмём клавишу Tab для описания

параметров контактной площадки. В

появившемся окне (см. рис. 12) необ�

ходимо задать параметры отверстия

(в поле Hole Information) и парамет�

ры контактной площадки (в поле Size

and Shape). Кроме этого, могут быть

заданы дополнительные параметры

(см. рис. 12), причём для площадки

под поверхностный монтаж сначала

необходимо указать слой в поле

Layer, после чего поле Hole Informa$

tion будет недоступно. Нумерацию

контактных площадок следует начи�

нать с единицы, т.к. здесь указывают�

ся номера физических выводов мик�

росхемы. Нулевой номер контакт�

ной площадки обычно используется

для крепежных отверстий. Для резис�
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Рис. 8. Установка скрытых выводов

Рис. 9. Свойства компонента



тора устанавливаем две контактные

площадки, причем первую – в начало

координат, а вторую на 10 мм правее

(4 шага основной сетки).

2. Вторым этапом создания посадоч�

ного места является разработка

графики, причём она должна быть

выполнена в определённом слое.

Более подробно работа со слоями в

программе Altium Designer будет

рассмотрена в одной из последую�

щих статей. В нашем случае контур

корпуса компонента должен быть

выполнен в слое Top Overlay. Выбор

слоёв производится кнопками с их

названиями в нижней части экрана

(см. рис. 10). Теперь в выбранном

слое будем создавать контур компо�

нента с помощью команды Place >

> Line, которая имеет некоторые от�

личия от аналогичной команды,

используемой в редакторе симво�

лов. Во�первых, переключение се�

ток при нажатии клавиши G здесь

происходит не между заранее за�

данными значениями, а путём вы�

бора сетки из списка (можно за�

дать пользовательское значение Set

Snap Grid). Во�вторых, вместо пяти

режимов рисования каждый режим

разбит на подрежимы, как показано

на рисунке 13. Режимы переключа�

ются комбинацией клавиш Shift +

+ Space и отличаются ортогональ�

ностью. Подрежимы переключаются

клавишей Shift и отличаются положе�

нием начального сегмента. После за�

вершения рисования корпуса резис�

тора изображение на экране должно

соответствовать рисунку 14.

В качестве особенностей данного

редактора (по сравнению с PCAD

Pattern Editor) необходимо отметить

следующие:

● не ставится атрибут RefDes; здесь,

как и в редакторе символов, он бу�

дет установлен автоматически над

корпусом компонента;

● не задаётся точка привязки, и отсут�

ствуют элементы Glue Point (точка

приклейки), Pick Point (точка захва�

та для автоматической установки)
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Рис. 10. Интерфейс редактора посадочных мест

Рис. 11. Настройки рабочей области редактора посадочных мест



и Test Point (тестовая точка). Точка

привязки по умолчанию задана в

начале координат, а точки Glue

Point и Pick Point с ней совпадают,

поэтому, если возникает необходи�

мость в их использовании, следует

располагать начало координат в ге�

ометрическом центре компонента.

Данную операцию удобно выпол�

нять по окончании разработки по�

садочного места (с помощью ко�

манды Edit>SetReference>Center).

Когда разработка посадочного места

резистора закончена, покажем, как соз�

дать более сложное посадочное место

микросхемы в режиме мастера. Для за�

пуска мастера выполним команду Tools

> Component Wizard. На экране появит�

ся диалоговое окно мастера создания

посадочных мест, и после нажатия

кнопки Next будет предложено выбрать

тип корпуса и единицы измерения (см.

рис. 15). Далее, в пошаговом режиме

будет предложено задать набор пара�

метров, которые описывают создавае�

мую модель, – например, параметры

контактной площадки, число выводов,

толщину линии корпуса и т.д. В нашем

случае создаём корпус с 14 выводами.

На последнем шаге будет предложено

указать название посадочного места.

После завершения работы мастера

сохраним библиотеку нажатием пик�

тограммы с изображением дискеты.

Теперь мы имеем в своём распоряже�

нии две библиотеки: в одной хранит�

ся символ микросхемы, а в другой –

посадочные места резистора и мик�

росхемы. Последним этапом нашей

работы, по результатам которого

можно будет использовать полнофунк�

циональный компонент на схеме и

плате, является установка ссылки для

компонента на модель посадочного

места. Данная процедура может быть

выполнена различными способами,

и существуют несколько вариантов

реализации библиотек. В рассматри�

ваемом примере будет показан ме�

тод, который предполагает хранение

всех компонентов и моделей в виде

интегрированных библиотек.

Для создания интегрированной

библиотеки выполним команду File>

> New>Project>Integrated Library, пос�

ле чего в структуре панели Project до�

бавится новый документ, который

необходимо сохранить, нажав на нём

правой кнопкой мыши и выполнив

команду Save Project. Теперь необхо�

димо добавить в структуру созданно�

го проекта ранее созданные библио�

теки путём их перемещения в дереве

панели Project (см. рис. 16).

Когда все необходимые библиоте�

ки находятся в структуре интегриро�

ванной библиотеки, можно выпол�

нять подключение моделей к соответ�

ствующим компонентам. В нашем

случае необходимо открыть библио�

теку символов и нажать кнопку Add

Footprint в окне подключения моде�
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Рис. 12. Параметры контактной площадки

Рис. 14. Готовое посадочное место

Рис. 15. Мастер создания посадочных мест

Рис. 13. Режимы рисования линии



лей (см. рис. 3). В результате на экране

появится окно PCB Model (см. рис. 17),

где после нажатия кнопки Browse не�

обходимо указать требуемый корпус.

Причём посадочные места, доступ�

ные по кнопке Browse, сразу имеют

ссылку на библиотеку посадочных

мест, которая находится в интегриро�

ванной библиотеке.

Теперь мы имеем готовый компо�

нент К1554ЛА3, но прежде чем его ис�

пользовать, необходимо сделать про�

верку. Она может быть выполнена по

отдельности на каждом этапе разра�

ботки (символ, посадочное место и

т.д.), или можно выполнить полную

проверку библиотеки компонентов.

Проверки первого типа выполняют�

ся командой Reports > Component Rule

Check, как в редакторе символов, так и

в редакторе посадочных мест, и фик�

сируют простейшие ошибки: нали�

чие дублирующихся выводов, атри�

бутов и т.д.

Общая проверка библиотеки ком�

понентов выполняется компиляцией,

по результатам которой будет сгене�

рирован файл *.IntLib, который мож�

но в дальнейшем использовать для

работы при создании схем. Итак, вы�

полним компиляцию проекта Project>

> Compile Integrated Library…, по ре�

зультатам которой интегрированная

библиотека будет автоматически

подключена к программе и готова к

использованию. В нашем случае мы

не стали задавать настройки компи�

ляции, т.е. сделали проверку библио�

теки по правилам, заданным «по

умолчанию» и, соответственно, избе�

жали каких�либо ошибок в проекте.

Компиляция и работа над её ошибка�

ми будут рассмотрены подробно в

одной из последующих статей.

В заключение следует отметить,

что процесс разработки библиотек в

программе Altium Designer значи�

тельно упрощён (по сравнению с

PCAD) за счёт исключения этапа за�

полнения таблицы соответствия вы�

водов, но при этом немного услож�

нён этап разработки символа, по�

скольку теперь необходимо рисовать

по отдельности каждую ячейку слож�

ной микросхемы. В данной статье

приведена самая предварительная

информация о разработке библио�

тек и ведения баз данных в Altium

Designer. Некоторые вопросы будут

рассмотрены в последующих публи�

кациях. Боле подробно с ней можно

ознакомиться в справочном руково�

дстве. В папке Help установочной ди�

ректории Altium Designer этой теме

посвящены документы AR0104, TU0103

и AP0134.

В следующей статье будет описан

процесс разработки электрических

принципиальных схем и компиля�

ция проекта.

В мае 2008 г. австралийская компа�

ния Altium выпустила новую версию

программы под названием Altium

Designer Summer 08. В данном цикле

статей рассматриваются основные

этапы работы с программой, кото�

рые не были изменены при выпуске

новой версии. Ознакомиться с новы�

ми возможностями пакета Altium

Designer Summer 08 можно на интер�

нет�странице www.altium.com/sum�

mer08.
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Рис. 16. Создание интегрированной библиотеки

Рис. 17. Подключение посадочного места




